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Overview
With TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture, allows TIBCO 
ActiveMatrix BusinessWorks™ users to have a seamless experience to capture changes in 
their desired data source or streams with an option to update multiple targets at once in 
real-time directly or via commonly used Message brokers such as Kafka or Apache Pulsar 
using TIBCO ActiveMatrix BusinessWorks™ Plug-in for Kafka or TIBCO ActiveMatrix 
BusinessWorks™ Plug-in for Apache Pulsar respectively.

TIBCO ActiveMatrix BusinessWorks™ is a scalable, extensible, and easy to use integration 
platform that you can use to develop integration projects. TIBCO ActiveMatrix 
BusinessWorks uses TIBCO Business Studio™ for BusinessWorks™ to define business 
processes and the TIBCO ActiveMatrix BusinessWorks process engine to run the business 
processes. For detailed discussion, see    TIBCO ActiveMatrix BusinessWorks™ Concepts.

With this plug-in, you can perform operations using the services supported by Apache 
Cassandra, IBM DB2, MongoDB, MSSQL, MySQL, Oracle Database, and PostgreSQL. The 
plug-in supports the following features:

JDBC Connection Resource
ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture plug-in uses a JDBC 
Connection shared resource to connect to a database at design time.

CDC-DB Listener Activity
With the Change Data Capture (CDC) DB Listener activity, you can capture change of events 
from supported databases to be processed in TIBCO BusinessWorks™ either using Kafka, 
Apache Pulsar, or any required activity.
Supported change events are insert, update, delete, and snapshot. The CDC DB Listener 
activity supports output formats in XML, JSON, or Avro.

CDC-NoSqlDB Listener Activity
With the Change Data Capture (CDC) NoSqlDB Listener activity, you can capture change of 
events from supported databases to be processed in TIBCO BusinessWorks™ either using 
Kafka, Apache Pulsar, or any required activity. Supported change events are insert, update, 
delete, and snapshot. The CDC NoSqlDB Listener activity supports output formats in XML 
and JSON.

CDC-SAP Listener Activity 
The CDC-SAP Listener activity allows you to receive full and delta data from SAP data 
sources or extractors using the SAP ODP 2.0 Framework. The data can either be processed 
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using one or more BW jobs in parallel. The output data can be in XML, JSON, or Avro 
format. The receipt of data is triggered either using scheduling in BusinessWorks or an 
event from the SAP system.

CDC Connection Resource for SAP Listener Activity
This plug-in now supports the CDC Connection Resource for CDC-SAP Listener activity that 
helps to establish client connection and server connection (if enabled). It allows the user to
 download the schema based on the ODP source.

CDC NoSQL Database Connection Resource

The NoSQL Connection Resource is used to maintain additional configuration required by 
the plug-in for supported NoSQL sources. Each NoSQL source is maintained in its own tab 
and section. This resource is used for establishing connections with NoSQL databases, 
which are utilized by the Debezium engine.

The NoSQL connection resource has two sections:

 l Cassandra

 l MongoDB

Support for OpenTelemetry (Open Tracing)
ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture now supports 
OpenTelemetry (Open Tracing). You can use custom tags to get more information about 
the current job being run by any activity in the palette.
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Getting Started
This tutorial is designed for beginners who want to use the ActiveMatrix BusinessWorks™ 
Plug-in for Change Data Capture in TIBCO Business Studio for BusinessWorks.

A typical workflow for the plug-in (to achieve different goals) includes creating a process, 
testing it in the debugger, and deploying the application.

ActiveMatrix BusinessWorks uses the Eclipse GUI provided by TIBCO Business Studio™ for 
BusinessWorks™ - Container Edition (hereinafter referred to as "TIBCO Business Studio") to 
define business processes and generate Enterprise Archives (EAR files) and push the 
application to cloud.

Most procedures in a typical workflow are performed in TIBCO Business Studio for 
BusinessWorks. See    Overview of TIBCO Business Studio for BusinessWorks for more 
information.

The following list contains a sequence of topics that can help you get started with 
ActiveMatrix BusinessWorks Plug-in for Change Data Capture:    

 1. Creating a Project

 2. Creating a JDBC Connection Resource

 3. Configuring a Process

 4. Testing a Process

Overview of TIBCO Business Studio for 
BusinessWorks
TIBCO Business Studio™ for BusinessWorks™ is an Eclipse-based integration development 
environment that is used to design, develop, and test ActiveMatrix BusinessWorks 
applications. The studio provides a workbench in which you can create, manage, and 
navigate resources in your workspace. A    workspace is the central location on your 
computer where all data files are stored. 
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The following table introduces the workbench UI elements:    

UI Element      Description      

Menu  Contains menu items such as File, Edit, Navigate, Search, Project, Run, 
Window, and Help.      

Toolbar Contains the following buttons for frequently used commands:        

 l New 

 l Save 

 l Enable/Disable Business Studio capabilities        

 l Create a new BusinessWorks Application Module

 l Debug As       

 l Run As

Perspectives  Contains an initial set and layout of views that are required to perform a 
certain task. TIBCO Business Studio for BusinessWorks launches the Design 
perspective by default. Use the Design perspective when designing a 
process and the Debug perspective when testing and debugging a process. 
To change the perspective, select        Window > Open Perspective > 
perspective_name from the main menu. Alternatively, click the Open 
Perspective  button from the top upper right of the workbench and 

select the perspective.      

Views Lists the resources and helps you navigate within the workbench. For 
example, the Project Explorer view displays the ActiveMatrix BusinessWorks 
applications, modules, and other resources in your workspace, and the 
Properties view displays the properties for the selected resource. To open a 
view, select        Window > Show View > view_nameview_name from the main 
menu.      

Editors Provides a canvas to configure, edit, or browse a resource. Double-click a 
resource in a view to open the appropriate editor for the selected resource. 
For example, double-click on a process        (MortgageAppConsumer.bwp) in the 
Project Explorer view to open the process in the editor.      
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UI Element      Description      

Palette  Contains a set of widgets and a palette library. A        palette groups activities 
that perform similar tasks, and provides quick access to activities when 
configuring a process.      

Creating a Project
The first task for using the plug-in is creating a project. After creating a project, you can 
add resources and processes.

An Eclipse project is an application module configured for TIBCO ActiveMatrix 
BusinessWorks™. An application module is the smallest unit of resources that is named, 
versioned, and packaged as part of an application.

Procedure
 1. From the menu, click File > New > BusinessWorks Resources to open the 

BusinessWorks Resource Wizard.

 2. In the Select a wizard dialog, click BusinessWorks Application Module and click 
Next to open the New BusinessWorks Application Module wizard.

 3. In the Project dialog, configure the project that you want to create: 

 4. In the Project name field, enter a project name. 

 5. If you do not want to use the default location (current workspace) for the project, 
clear the Use default location checkbox and click Browse to select a new location. 

 6. Use the default version of the application module, or enter a new version in the 
Version field. 

 7. Keep the Create empty process and Create Application checkboxes selected to 
automatically create an empty process and an application when creating the project. 

 8. Optional: Select the Use Java configuration checkbox if you want to create a Java 
module. A Java module provides the Java tool capabilities. 

 9. Click Finish to create the project.
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Result
The project with the specified settings is displayed in the Project Explorer view. 

Creating a JDBC Connection
Create a JDBC Connection shared resource to retrieve connection details and establish  the 
CDC connection      with the Change Data Capture instance.

Before you begin
The  JDBC Connection resource is available at the Resources level. Ensure that you have 
created a project, as described in Creating a Project.

Procedure
 1. Expand the created project in the Project Explorer view. 

 2. Right-click the Resources folder and click New >  JDBC Connection to open the 
JDBC Connection wizard. 

 3. The resource folder, the package name, and resource name of the  JDBC connection 
are provided by default. If you do not want to use the default configurations, change 
them accordingly. Click Finish to open the  JDBC connection editor. 
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 4. Configure the  JDBC Connection resource in the JDBC  connection editor. For 
information about the configuration fields, see JDBC Connection Resource. 

 5. Click Test Connection to validate the connection.

Configuring a Process
A newly created project contains an empty process. Configure the process by adding 
activities, conditions, and services to complete a task.

Before you begin
Ensure that you have created an empty process when creating a project. For more details, 
see Creating a Project.

Procedure
 1. In the Project Explorer view, double-click the created project and open the empty 

process from the Processes folder.

 2. Select the activity from the Palette view and drop it in the Process editor. For 
example, select  the CDC-DB listener activity from the CDC palette.
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 3. Click and drag icon  to create a transition between the added activities.

 4. Configure the added  CDC-DB activity, as described in Palette topic.

Note: A  JDBC connection is required when configuring the plug-in 
activities. For more information about creating a JDBC connection, see 
Creating a JDBC Connection.

 5. Click File > Save to save the process.

Testing the Process
After configuring a process, you can test the process to check whether it  completes your 
task. Debug the application you have configured to ensure that the application is 
configured correctly.

Before you begin
You must configure a process as described in Configuring a Process.

Procedure
 1. In TIBCO Business Studio for BusinessWorks, open the process you have configured.

 2. On the toolbar, click   Debug > Debug Configurations. 

 3. In the left panel, click BusinessWorks Application > BWApplication. 

 4. Ensure that only the application you want to debug and run is selected in the 
Applications tab in the right panel. 

 5. Click the Advanced tab and click Browse to locate the logback file. By default, the 
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log file resides in the <TIBCO_HOME>/bw/<version_number>/config/design/logback 
directory and error logs are captured. For more information, see Log Management. 

 6. Click Debug.

TIBCO Business Studio for BusinessWorks changes to the Debug perspective. Logs are 
displayed in the Console view.

 7. On the Debug tab, expand the running process and click an activity.

 8. From the upper-right corner, click the Job Data tab, and then click the Output tab to 
check the activity output.

What to do next
After you have tested a process, you can check the output of the activities. See Checking 
Output of an Activity. The final task is to deploy an application. See the Getting Started 
tutorial.

Checking Output of an Activity
After debugging the application, you can check the output of activities.

Procedure
 1. In the left panel, expand BusinessWorks Application > BWApplication and click the 

activity in the upper left panel. 

 2. In the upper right panel, click the Job Data view and click Output. 

Result
The output of the activity is displayed. 

What to do next
Check the activity output in the plug-in logs. For more information, see Log Management.
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Pushing an Application In TIBCO Platform
This section describes how to push an application containing TIBCO ActiveMatrix 
BusinessWorks™ Plug-in for Change Data Capture in TIBCO® Platform.

To ensure the functionality of the TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change 
Data Capture in the TIBCO® Platform, generate and upload the plug-in supplements into 
the TIBCO® Control Plane before deploying any application that uses the plug-in.

Generating Plug-in Supplements

Procedure
 1. Navigate to the directory TIBCO_

HOME/bw/palettes/cdc/<version>/runtime/plugins.

 2. Do one of the following:

 l For IBM DB2 - Select the CDC tpshell folder com.tibco.tpshell.cdcdb2_
6.1.0.xxx and create a .zip file named cdc.zip.

 l For SAP - Select the CDC tpshell folder com.tibco.tpshell.cdcsap_3.1.8.xxx 
and create a .zip file named cdc.zip.

 3. Copy the      cdc.zip file into a temporary (supplement) directory on your local machine. 
Do not add any other files to this directory.

Note: 
 l The temporary directory must contain       only the      cdc.zip file.

 l Supplementing is mandatory to push any Change Data Capture 
application.

Uploading Plug-in Supplements In TIBCO Platform

Procedure
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 1. Log in to TIBCO® Control Plane.

 2. Click Data Planes from the left navigation.

 3. On the Data Plane card of your choice, click Go to Data Plane.

 4. In the Capabilities section, click the BWCE capability card.

 5. In the Available Supplements section, click Upload Supplements.

 6. In the Upload Supplements dialog, select a plug-in or driver from the dropdown list.

 7. Drag your supplement cdc.zip archive onto the window. You can also click browse 
to upload to find the files on your system and click Open to upload the selected file.

Note: Adding the plug-in supplement is necessary only once for a Data plane. 
Subsequent application pushes in that Data Plane automatically use the 
supplemented plug-in.

Uploading Plug-in Supplements via API

For details about uploading supplements using the API, see the API for Uploading 
Supplements section in the TIBCO® Control Plane documentation.

https://docs.tibco.com/pub/platform-cp/latest/doc/html/Subsystems/bwce-capability/bwce-user-guide/provisioned-software-plugins.htm
https://docs.tibco.com/pub/platform-cp/latest/doc/html/Subsystems/bwce-capability/bwce-user-guide/provisioned-software-plugins.htm
https://docs.tibco.com/pub/platform-cp/latest/doc/html/Default.htm
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Deploying an Application
You can deploy applications and then manage them by using TIBCO Enterprise 
Administrator.

Before deploying an application, complete the following tasks:

 l Creating a Project

 l Generating an EAR File
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Important: Before you run the NoSQL Cassandra Database activity, add the 
following VM arguments. These arguments are mandatory for the Debezium 
engine to work with Cassandra. To ensure that the activity runs smoothly, 
append these arguments to your existing VM arguments:

--add-exports="java.base/jdk.internal.misc=ALL-UNNAMED" 
 --add-exports="java.base/jdk.internal.ref=ALL-UNNAMED" 
 --add-exports="java.base/sun.nio.ch=ALL-UNNAMED" 
 --add-
exports="java.management.rmi/com.sun.jmx.remote.internal.rmi=AL
L-UNNAMED" 
 --add-exports="java.rmi/sun.rmi.registry=ALL-UNNAMED" 
 --add-exports="java.rmi/sun.rmi.server=ALL-UNNAMED" 
 --add-exports="java.sql/java.sql=ALL-UNNAMED" 
 --add-opens="java.base/java.lang.module=ALL-UNNAMED" 
 --add-opens="java.base/jdk.internal.loader=ALL-UNNAMED" 
 --add-opens="java.base/jdk.internal.ref=ALL-UNNAMED" 
 --add-opens="java.base/jdk.internal.reflect=ALL-UNNAMED" 
 --add-opens="java.base/jdk.internal.math=ALL-UNNAMED" 
 --add-opens="java.base/jdk.internal.module=ALL-UNNAMED" 
 --add-opens="java.base/jdk.internal.util.jar=ALL-UNNAMED" 
 --add-opens="jdk.management/com.sun.management.internal=ALL-
UNNAMED" 
 --add-opens="java.base/java.io=ALL-UNNAMED" 
 --add-opens="java.base/sun.nio.ch=ALL-UNNAMED" 
 --add-opens="java.base/java.lang=ALL-UNNAMED" 
 --add-opens="java.base/java.lang.reflect=ALL-UNNAMED"

If you rerun the same activity, you must:

 l Use a new configuration

 l Append the VM arguments again

Deploying an application typically includes the following tasks:

 1. Upload an EAR file. 

Note: You can deploy an application EAR file by using the command-line 
mode with the bwadmin utility. For more information, see TIBCO 
ActiveMatrix BusinessWorks™ Administration.

 2. Deploy the application. 
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 3.  Configure the application. 

 4.  Start the application.     

Generating an EAR File
Application archives are enterprise archive (EAR) files that are created in TIBCO Business 
Studio for BusinessWorks. An EAR file is required when deploying an application.

There are many ways to generate an EAR file, the following is one method. For more 
information, see TIBCO ActiveMatrix BusinessWorks™ Administration. 

Before you begin
Create an application project as described in Creating a Project. 

Procedure
 1. From the File Explorer view, click the Open Directory to Browse  icon. 

 2. Select the folder where you want to generate the EAR file and click OK. 

The new folder is displayed in the File Explorer view.

 3. Drag the application from the Project Explorer view to the new folder in the File 
Explorer view. 

The EAR file is generated with the following name: <name>.<application>_
<version>.ear.
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JDBC Connection Resource
During the  design time, the JDBC connection resource creates a connection between the 
plug-in and supported databases.
During the  runtime,  the JDBC connection resource details is used to create a connection 
between the plug-in and supported databases.

The JDBC connection resource has two tabs; General and JDBC Connection.

General
The General panel contains the following fields. 

Property Module 
Property? 

Description

Package No The name of the package where the JDBC connection 
resource is added.

Name No The name to be displayed as the label for the JDBC shared 
resource in the process.

Description No The name to be displayed as the label for the JDBC 
connection resource.

JDBC Connection
In the JDBC Connection panel, you can specify the connection details to establish a 
connection with Change Data Capture. The following fields are included in the JDBC 
Connection panel.
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Property Module 
Property? 

Description

Connection
Type

Yes The Connection Type used is Direct

Maximum 
Connections

Yes The maximum number of connections that can be 
established

Login 
Credentials

Yes The database credentials used for creating a connection

Username Yes Enter the username of the database to be used for 
authentication

Password Yes Enter the password of the database to be used for 
authentication

Database 
Driver

Yes Select the class for the database driver

Database URL Yes It is a connection string representing host port and database 
name

Login Timeout 
(secs)

Yes The time (in seconds) to wait  before timing out when 
establishing a connection. The default login timeout is 30 
seconds.

Connection 
Idle Timeout

Yes The  maximum length of time (in seconds) that a connection 
is idle until any activity is performed. The default connection 
idle timeout is 300 seconds.
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CDC Connection Resource
The CDC Connection Resource is used to maintain additional configuration required by the 
plug-in for supported CDC source such as SAP. Each CDC source is maintained in its own 
tab and section.

The CDC connection resource has two sections; General and SAP Connection.

General
The General tab is applicable to all CDC sources. The General panel contains the following 
fields.

Property Module 
Property?

Description

Package No The name of the package where the CDC connection 
resource is added.

Name No The name to be displayed as the label for the CDC shared 
resource in the process.

Description No The name to be displayed as the label for the CDC 
connection resource.

SAP Connection
The SAP Connection panel allows you to configure the client connection and server 
connection (if enabled) between the plug-in and SAP server.
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Important: When creating a new CDC Connection resource for first time in a 
project, predefined module properties would be automatically created in the 
project. These modules properties have the same naming conventions as the 
module properties created by the TIBCO ActiveMatrix BusinessWorks Plug-in for 
SAP Solutions.

In the SAP Connection panel, you can specify the connection details required to capture 
and process Change Data Capture data from the SAP server. The SAP Connection includes 
three tabs: Client Connection, Server Connection, and ODP Sources.
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Client Connection

At design-time, the client connection is used to get list of SAP ODP sources and download 
the metadata of a SAP ODP source.

At runtime, the client connection is used to retrieve CDC data from the SAP server.
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The Client Connection tab contains the following fields.

Property Module 
Property? 

Description

Connection
Type

No The client connection type. The plug-in provides the 
following client connection types: Dedicated App Server 
Load Balancing. The default type is Dedicated App Server.

Message Server Yes An SAP message server can be used for load distribution 
and communication between individual application servers 
in an SAP BW system.

Application 
Server

Yes The network name of the machine where the SAP system 
exists.

Note: This field is displayed only when you select 
Dedicated App Server from the Connection Type list.

System Number Yes The SAP system number.

Note: This field is displayed only when you select 
Dedicated App Server from the Connection Type list.

System Name Yes The SAP system ID or the SAP message server tcp/ip port 
number.

Note: This field is displayed only when you select Load 
Balancing from the Connection Type list.

Client Yes The SAP client number.

User Name Yes Enter the username of the database to be used for 
authentication on to SAP client.

Password Yes Enter the password of the database to be used for 
authentication.

Logon Group Yes The SAP logon group server to be used with the load 
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Property Module 
Property? 

Description

Name balancing connection. The default value is PUBLIC. Note: 
This field is displayed only when you select Load Balancing 
from the Connection Type list.

The following advanced options are displayed when you click Show/Hide Advanced Options

Language No Select the language used to connect to the SAP system. 
The default language is English.

Code Page Yes The character set used by the SAP system. The default 
value is blank.

Note: This field can only be specified in the special 
cases.

Maximum 
Number of 
Reconnection 
Attempts

Yes The maximum number of times that the plug-in can retry 
to establish a connection before sending a  request to the 
SAP system. The default value is -1, which indicates that 
the plug-in can retry indefinitely.

Interval 
between 
Reconnection 
Attempts (ms)

Yes The time interval in milliseconds between two successive 
attempts to establish a connection before sending a 
request to the SAP system. The default value is 30000.

Disable 
Connection 
Pooling

Yes Whether to disable connection pooling. If you want to close 
the connection automatically after the request to SAP is 
completed, select this checkbox. This checkbox is cleared 
by default.

RFC Trace Yes Whether to enable the RFC trace.
The value of 1 indicates that the RFC trace is enabled. The 
value of 0 indicates that the RFC trace is disabled. The 
default value is 0.

Use SAP GUI Yes To enable the SAP GUI. 
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Property Module 
Property? 

Description

The following values indicate different RFC operations:

 l When the value is 1: The SAP GUI is enabled to carry 
out debugging of RFCs.

 l When the value is 2: The SAP GUI is enabled to carry 
out debugging of RFCs until it is used by the 
invocation of an RFC.

 l When the value is 0: The SAP GUI is disabled to carry 
out debugging of RFCs. 
The default value is 0.

Third-Party 
Library Options

Yes Specifies SAP JCo properties, which are used by the CDC 
Connection shared resource.

Note: It is a semicolon separated list of SAP JCo 
properties.

While specifying an SAP JCo property, which is available as 
a property in the CDC Connection shared resource then the 
value specified with the SAP JCo property is used. If an SAP 
JCo property is specified more than once then the last 
value is used.

Server Connection

If enabled, the server connection is only used during runtime and in scenario where 
proessing in BusinessWorks should be executed following an event from SAP server. The 
Server Connection tab contains the following fields.

Property Module 
Property?

Description

Enable Yes If the Enabled checkbox is selected then the Change Data 
Capture data would be processed by a SAP event sent from 
SAP server as a RFC call. To support the RFC call, the 



TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture User Guide

27 | CDC Connection Resource

Property Module 
Property?

Description

properties maintained in the Server Connection tab need to 
be maintained accordingly. The event must be sent from 
SAP using function module BAPI_XBP_EVENT_RAISE. No 
export parameters are required on the RFC call. Default 
value is unselected. 

Connection
Type

No The client connection type. The plug-in provides the 
following client connection types: Dedicated App Server 
Load Balancing. The default type is Dedicated App Server.

Program ID Yes The program ID that identifies the RFC server program for 
the SAP system. The Program ID is required by the plug-in 
but it is up to you to define the Program ID based on the 
requirements. The program ID is case sensitive.

Note: RFC destination corresponding to the program ID 
must exist in the SAP system. If a server connection is not 
used by an activity, the program ID is ignored and not 
registered in the SAP system.

Important: If configuring the Trigger Event in the CDC 
SAP listener activity as SAP then ensure that the program 
ID is unique across all CDC SAP listener activities.

Gateway 
Service

Yes The SAP gateway service or SAP Gateway tcp/ip port 
number. The default service is sapgw00.

Note: When specifying a value as a service name, the 
service name must exist in the services file maintained at 
the operating system level. To avoid having to maintain 
the services file, the TCP/IP port number such as 33xx, 
where xx is the range from 00 to 99, depending on the 
instance number of the SAP server, can be specified as a 
value instead.

Gateway Host Yes The Gateway host name, IP address, or router string. If no 
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Property Module 
Property?

Description

machine exists as a gateway host, this field is specified as 
the application server.

The following advanced options are displayed when you click Show/Hide Advanced Options:  

Maximum time 
between two 
startup 
attempts in 
case of failure 
(secs)

Yes The maximum time interval in seconds between two 
successive attempts to establish a connection with the 
gateway host. If the connection cannot be established after 
the maximum time interval, the server connection is 
suspended.

The default value is 60.

Max 
Connections

  The number of SAP connections in the server connection. 
The default value is 1.

RFC Trace Yes Whether to enable the RFC trace.

The value of 1 indicates that the RFC trace is enabled. The 
value of 0 indicates that the RFC trace is disabled. The 
default value is 0.

Third-Party 
Library 
Options

Yes Specifies SAP JCo properties, which are used by the CDC 
Connection shared resource.

Note: It is a semicolon separated list of SAP JCo 
properties.

While specifying an SAP JCo property, which is available as a 
property in the CDC Connection shared resource then the 
value specified with the SAP JCo property is used. If an SAP 
JCo property is specified more than once then the last value 
is used.
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NoSQL Connection Resource
The NoSQL Connection Resource is used to maintain additional configuration required by 
the plug-in for supported NoSQL sources. Each NoSQL source is maintained in its own tab 
and section.

The NoSQL connection resource has two sections: Cassandra and MongoDB.

General
The General tab is applicable to all CDC sources. The General panel contains the following 
fields:

Property Module 
Property? 

Description

Package No The name of the package where the CDC connection 
resource is added.

Name No The name to be displayed as the label for the CDC shared 
resource in the process.

Description No The name to be displayed as the label for the CDC 
connection resource.

Cassandra Connection
The Cassandra Connection panel allows you to configure the client connection between the 
plug-in and Cassandra server.

In the Cassandra Connection panel, you can specify the connection details required to 
capture and process NoSql data from the Cassandra server.
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Cassandra Connection

The Client Connection tab contains the following fields:

Property Module 
Property? 

Description

Database Host Yes Specify the hostname or network address of the 
Cassandra server.

Database Port Yes Specify the port of the Cassandra server.

Database User Yes Specify the username that you created in a Cassandra 
database.

Database 
Password

Yes Specify the password that is used to access the database.

Database Yes Enter the name for the database that you want to connect 
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Property Module 
Property? 

Description

to.

Keyspace Name Yes The name of the keyspace to be used for the session 
created.

Authentication 
Provider

Yes Specify the authentication service provider used by the 
database for verifying user credentials.

Default: PlainTextAuthProvider

Data Center Yes Specify the data center associated with the Cassandra.

Default: datacenter1

MongoDB Connection
The MongoDB Connection panel allows you to configure the client connection between the 
plug-in and MongoDB server.

In the MongoDB Connection panel, you can specify the connection details required to 
capture and process Change Data Capture data from the MongoDB database.
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MongoDB Connection

The Client Connection tab contains the following fields:

Property Module 
Property?

Description

Database Host Yes Specify the hostname or network address of the 
MongoDB server.

Database Port Yes Specify the port of the MongoDB server.

Database User Yes Specify the username that you created in a MongoDB 
database.

Database 
Password

Yes Specify the password that is used to access the 
database.

Database Yes Specify the name for the database that you want to 
connect to.

Replica Set Yes Specify the name of the MongoDB replica set.

Enable SSL No Select to enable the SSL for MongoDB database.

SSL Config File 
Path

Yes Provide the path to a file containing keystore and 
truststore file.
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Palette
A palette groups the activities that connect to the same external applications together. The 
TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture palette is added to 
TIBCO Business Studio for BusinessWorks after installing TIBCO ActiveMatrix 
BusinessWorks™ Plug-in for Change Data Capture.

The TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture palette contains 
the following activities for supported CDC sources.

 l CDC DB Listener Activity

 l CDC SAP Listener Activity

 l CDC NoSql DB Listener Activity

CDC DB Listener Activity
The CDC-DB Listener activity is a BusinessWorks EventSource and listens to the operations 
performed on database tables. When CDC is enabled for a table the data change events for 
the respective table are logged. The plug-in collects these data change event logs and 
returns the details of the data change.

By default, the plug-in captures change data events for Insert (c), Update (u), Delete (d), 
and Snapshot operations.

However, you can pass the appropriate Operation Options value so that the data changes 
specific to these activities performed on a table are captured.

Note: 
 l The CDC-DB listener activity does not support concurrency, as the events 

are read sequentially.

 l The Flowlimit is not supported in the CDC-DB listener activity.
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CDC Database Configuration Preferences
You can specify the Database preferences by setting the default values for the Operation 
Options and Output Formats.

The Operation Options and Output Formats fields are also available on the CDC-DB 
Listener's Advanced tab. The default values listed in the CDC Database Configuration 
Preferences window are preferred until you add the CDC-DB activity to the Palette.

Procedure
 1. From the menu, click Window > Preferences to open the Preferences Wizard.

 2. In the Preferences wizard, click CDC Plugin and then click CDC Database 
Configuration Preferences to open the CDC Database Configuration Preferences 
wizard.

 3. By default the Offset Flush Interval is set to 100 milliseconds. Choose the desired 
Operation Options and Output Formats, click Apply to set these values as default.
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Note: Encrypt Database  is supported only for MSSQL database server in 
configuration preferences setting.

 4. Now, click Apply and Close.

Note: In the CDC Database Configuration Preferences Wizard, the 
Database Encrypt checkbox can trust server-signed certificates or use a 
trust store for the server's signer certificates. In the latter case, the path to 
trust store and the trust store password should be provided as 
configuration properties ("database.ssl.truststore", and 
"database.ssl.truststore.password") using the 
com.tibco.bw.palette.cdc.additionalDbProperties module property.

General
The General tab contains the following fields. 

Property Module 
Property?

Visual 
Diff?

Description

Name Yes Yes Name of the palette activity.

JDBC 
Connection

Yes Yes The name to be displayed as the label for the 
JDBC connection resource.

Table Name Yes Yes The table name displayed as the label. Multiple 
tables can be specified in a comma-separated list.

Note: If listening table is deleted inside DB, 
the plug-in does not throw any exception.

Output 
Format

No Yes The following are the output formats:

 l JSON

 l XML
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Property Module 
Property?

Visual 
Diff?

Description

 l Avro

Note: For MSSQL, Oracle, MySQL, 
PostgreSQL, and IBM DB2 for Output 
Format JSON and XML, if data is "null" 
as literal string, then it is treated as 
database null instead of "null" as literal 
string.

Database 
Server ID

Yes Yes When MySQL DB connection resource is selected, 
Database Server Id field is displayed.

Note: The Database Server Id value must be 
a non-zero positive integer.

Description
Provide a short description for the activity.

Advanced
The Advanced tab contains the following fields.

Property Module 
Property? 

Visual 
Diff?

Description

Sequence 
Key

No Yes This field contains an XPath expression that 
specifies which processes should run in sequence. 
Process instances with sequencing keys evaluating 
to the same value, are executed sequentially in the 
sequence the process instance was created.

Custom Job No Yes This field contains an XPath expression that 
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Property Module 
Property? 

Visual 
Diff?

Description

Id specifies a custom ID for the process instance. 

Operation 
Options

Yes Yes Facilitate the selection of the appropriate 
operation.

 l Insert: When the Insert checkbox is selected 
and insert operation is performed on DB, we 
receive the event with Opcode value c.

 l Update: When the Update checkbox is 
selected and update operation is performed 
on DB, we receive the event with Opcode 
value u.

 l Delete: When the Delete checkbox is 
selected and delete operation is performed 
on DB, we receive the event with Opcode 
value d.

 l Snapshot: Scans database tables or objects 
and creates  reference point to capture 
change data information and we receive the 
event with Opcode value r.

Note: This Snapshot option performs 
read operation when app is running for 
the first time.

 l Process Nullable Columns For Avro: When 
Process Nullable Columns For Avro 
checkbox is selected for Output Format Avro, 
it handles the Null values or datatype 
mismatch.

Note: The Process Nullable Columns 
For Avro does not support Visual Diff.
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Module Property

Any additional database  properties can be specified using the 
com.tibco.bw.palette.cdc.additionalDbProperties module property.

Note: 
 l If you specify an include column list in the module property and exclude 

the primary key column, the primary key is not shown in the activity 
output.

 l When the provide.transaction.metadata property is set to true, 
transaction metadata is not returned in the response.

 l You can provide multiple additionalDbProperties by separating them 
with a semicolon (For example, prop_name1=prop_value1;prop_
name2=prop_value2).

 l For Oracle, to ensure all field values are visible in source and target data 
during updates, run: 
ALTER TABLE <TABLE NAME> ADD SUPPLEMENTAL LOG DATA (ALL) 
COLUMNS;

 l For PostgreSQL, if the offset file is deleted and the application restarts, the 
connector retrieves the last committed change event from the database 
and returns the previous record, so the last record before the restart is 
returned again.

Tags

Conversations
You can use the Conversations tab to initiate or join a conversation.

Conversations receive a message after the creation of the process instance, which is 
initiated or joined by an activity. This activity can be used to initiate a conversation. Click 
the Add New Conversation  icon to initiate a conversation. For more information about 
conversations, see TIBCO ActiveMatrix BusinessWorks™ Application Design.
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Output
The following is the output for the activity.

Output 
Item

Data Type Description

Global 
Scope

String The Global scope checkbox makes output variable  of the activity 
from current scope to global level which is at the process level.

item? String
Header: Based on the output formats, the output item differs

 l dbName?: The database name with which the activity is 
performed

 l schema?: The schema with which the activity is 
performed

 l table?: The table on which operations are performed

 l opcode?: The opcode value that is set to perform a 
specific operation

 l timestamp?: The time at which an event occurs

 l date?: The date when an event is performed

 l time?: The time required to perform the specific activity

 l messageID? It is an Unique ID for an event

Body: Data of records that undergo change based on the 
output formats that are chosen.

 l For JSON:

data?: Depending on the insert, update, and delete 
operations performed, we obtain respective source and 
target values.

 o For Insert operation the source is null, target 
consists of values which are inserted.
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Output 
Item

Data Type Description

 o For Update operation the source consists of old 
values and target consists of new updated values.

 o For Delete operation the source consists of 
deleted values and target is null.

 l For XML:

Source Column and Target Column: Depending on the 
insert, update, and delete operations performed, we 
obtain respective Source Column and Target Column 
values.

 o For Insert operation the Source Column is null, 
whereas the Target Column consists of values 
which are inserted.

 o For Update operation the Source Column consists 
of old values and the Target Column consists of 
new updated values.

 o For Delete operation the Source Column consists 
of deleted values and the Target Column is null.

 l For  Avro:

sourceData? and targetData?: Depending on the insert, 
update, and delete operations performed, we obtain 
respective sourceData? and targetData? values

 o For Insert operation there is no sourceData? 
obtained, whereas the targetData? consists of 
newly created values

 o For Update operation the sourceData? consists of 
old values and the targetData? consists of new 
updated values

 o For Delete operation the sourceData? consists of 
deleted values and there is no  targetData? 
obtained



TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture User Guide

41 | Palette

Fault
The Fault tab lists exceptions that are generated by this activity.

Error Schema Element Data Type Description

msg  string   The error message returned by the plug-in. 

msgCode string The error code returned by the plug-in

 l CDCPluginException: The exception is generated when the plug-in cannot send the 
request or parse the  response.

 l CDCDBException: The exception is generated when any database related error 
occurs.

Support of Database Reconnection
In the event the connection between the database and plug-in is interrupted, the plug-in 
tries to reconnect to the database by using a heartbeat table which is configurable using 
module properties.

If the heartbeat table is enabled and the plug-in does not receive a change event from that 
table then the plug-in generates an exception to notify loss of connection to the database.

Following are the module properties with datatypes.

Module Property Default 
value

Datatype Description

com.tibco.bw.palette.cdc.HBENABLE False Boolean Enables the 
heartbeat table for 
reconnection. By 
default, it is not 
enabled.

com.tibco.bw.palette.cdc.HBPOLLINGINTERVAL 30000 Long Specifies the 
interval in 
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Module Property Default 
value

Datatype Description

milliseconds for 
checking the 
change event  from 
the heartbeat 
table.

com.tibco.bw.palette.cdc.HBPOLLINGATTEMPTS 5 Integer Specifies the 
number of 
iterations for 
checking the 
change event from 
the heartbeat 
table.

Supported Datatypes
The following datatypes are supported for ActiveMatrix BusinessWorks™ Plug-in for Change 
Data Capture:

Database Type Database Server

BIT MSSQL

DECIMAL(10, 2) MSSQL

FLOAT MSSQL

INT MSSQL

SMALLINT MSSQL

TINYINT MSSQL
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Database Type Database Server

Money MSSQL

NUMERIC(8, 4) MSSQL

REAL MSSQL

SMALLMONEY MSSQL

DATE MSSQL

DATETIME MSSQL

DATETIME2(3) MSSQL

SMALLDATETIME MSSQL

TIME(2) MSSQL

CHAR(10) MSSQL

VARCHAR(50) MSSQL

TEXT MSSQL

NCHAR(10) MSSQL

NVARCHAR(50) MSSQL

NTEXT MSSQL

BINARY(10) MSSQL

VARBINARY(50) MSSQL

IMAGE MSSQL

UNIQUEIDENTIFIER MSSQL
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Database Type Database Server

XML MSSQL

Number Oracle

Varchar Oracle

Date Oracle

Timestamp Oracle

CHAR Oracle

FLOAT Oracle

DOUBLE PRECISION Oracle

INT Oracle

SMALL INT Oracle

Number (Decimal) Oracle

INT KEY PostgreSQL

BOOLEAN PostgreSQL

SMALLINT PostgreSQL

INTEGER PostgreSQL

BIGINT PostgreSQL

REAL PostgreSQL

DOUBLE PRECISION PostgreSQL

NUMERIC(10, 2) PostgreSQL
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Database Type Database Server

TEXT PostgreSQL

VARCHAR(255) PostgreSQL

CHAR(10) PostgreSQL

BYTEA PostgreSQL

INET PostgreSQL

CIDR, , , , TIMETZ, PostgreSQL

UUID PostgreSQL

DATE PostgreSQL

TIME PostgreSQL

TIMETZ PostgreSQL

TIMESTAMP PostgreSQL

TIMESTAMPTZ PostgreSQL

HSTORE PostgreSQL

XML PostgreSQL

BOOLEAN, BOOL MySQL

BIT(1) MySQL

BIT(>1) MySQL

TINYINT MySQL

SMALLINT[(M)] MySQL
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Database Type Database Server

MEDIUMINT[(M)] MySQL

INT, INTEGER[(M)] MySQL

BIGINT[(M)] MySQL

REAL[(M,D)] MySQL

FLOAT[(P)] MySQL

DOUBLE[(M,D)] MySQL

CHAR(M)] MySQL

VARCHAR(M)] MySQL

BINARY(M)] MySQL

VARBINARY(M)] MySQL

TINYBLOB MySQL

TINYTEXT MySQL

BLOB MySQL

TEXT MySQL

MEDIUMBLOB MySQL

MEDIUMTEXT MySQL

LONGBLOB MySQL

LONGTEXT MySQL

JSON MySQL
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Database Type Database Server

ENUM MySQL

SET MySQL

YEAR[(2|4)] MySQL

TIMESTAMP[(M)] MySQL

DATE MySQL

TIME MySQL

DATETIME MySQL

NUMERIC[(M[,D])] MySQL

DECIMAL[(M[,D])] MySQL

SPATIAL MySQL

INTEGER DB2

SMALLINT DB2

BIGINT DB2

DECIMAL DB2

FLOAT DB2

REAL DB2

DOUBLE DB2

CHAR DB2

VARCHAR DB2
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Database Type Database Server

DATE DB2

TIME DB2

TIMESTAMP DB2

VARGRAPHIC DB2

BINARY DB2

VARBINARY DB2

Note: 
 l CLOB and BLOB datatypes are not supported when Oracle DB is used.

 l The plug-in does not support the Oracle Interval datatype.

 l The MSSQL Boolean datatype output comes as true or false instead of bit 
1 or 0.

 l The Oracle Timestamp datatype value comes as epoch time.

 l The CLOB, DBCLOB,  Boolean, and XML datatypes are not supported when 
DB2 is used.

CDC-SAP Listener Activity
The CDC SAP Listener activity listens to Change Data Capture data from SAP using the SAP 
ODP 2.0 framework. 
The ODP sources supported are datasources/extractors that are provided by SAP or 
custom. The Change Data Capture data can either be a full extract (snapshot) or a delta.
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Important: 
 l The replication mode available in ODP as Recovery of Previous Deltas 

is not supported. In the event there is an issue with the processing of delta 
data, it is recommended that full extracts be used to remediate any issues 
encoutered during delta processing.

 l The maximum number of records received from the SAP ODP source is not 
configurable in the plug-in. The maximum number of records is 52428800. 
Flow limit and load balancing are not supported by the CDC SAP Listener 
activity.

General
The General tab contains the following fields.

Property Module 
Property? 

Visual 
Diff?

Description

Name No Yes Name of the palette activity.

CDC 
Resource

Yes Yes The CDC Connection shared resource establishes 
connections between the plug-in and the SAP 
system at run time. Ensure that you have created 
a CDC Connection shared resource.

Subscriber 
Type

No Yes Subscriber Type describes the target application 
that processes the Change Data Capture data.

Important: The Subscriber type must match 
the value defined in SAP transaction ODQMON 
that is relevant for the receipt of data from the 
plug-in.

Subscriber 
Name

Yes Yes Subscriber Name is the subscription name 
associated to the target application that processes 
the Change Data Capture data.
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Property Module 
Property? 

Visual 
Diff?

Description

Important: The Subscriber Name must match 
the Subscription value defined in SAP 
transaction ODQMON that is relevant for the 
receipt of data from the plug-in.

Context No Yes The type of the ODP source that generates the 
Change Data Capture data.

ODP Name No Yes Name of the ODP source.

ODP Mode No Yes Mode to extract data from a SAP ODP source, the 
valid values include Full and Delta.

Output 
Format

No Yes The following are the output formats:

 l JSON

 l XML

 l Avro

Description
Provide a short description for the activity.

Advanced
The Advanced tab contains the following fields.

Property Module 
Property? 

Visual 
Diff?

Description

Sequence 
Key

No Yes This field contains an XPath expression that 
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Property Module 
Property? 

Visual 
Diff?

Description

specifies the order in which the process runs. 
Process instances with sequencing keys that have 
the same value are run sequentially in the order in 
which the process instances were created.

Custom Job 
Id

No Yes This field contains an XPath expression that 
specifies a custom job ID for the process instance. 
This ID is displayed in the $_processContext 
process variable. The custom job ID for the process 
instance.

Batch Size Yes Yes The number of records that a job can contain. The 
defaults to -1, which means that a job contains all 
of the data from the ODP source.

Explicit 
Close 

No Yes Do not close the request automatically, the receipt 
of data is confirmed separately.

Return Error 
on Close

No Yes Subscriber is canceled and data is not collected.

Trigger 
Event

No Yes Specifies when to process the data from the ODP 
source. The  valid values include Local and SAP. It 
defaults to Local. Local means that the extraction 
is triggered by local timer. SAP means the receipt 
of data  by an event from SAP server.

Start Time Yes Yes Time to start the receipt of data, it is available only 
when the trigger event Local is selected.

Run Once No Yes Indicates if the receipt of data  runs only once. It 
defaults to true, it is available only when the 
trigger event Local is selected.

Time 
Interval 

Yes Yes The time interval between processing, it is 
available only when the trigger event Local is 
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Property Module 
Property? 

Visual 
Diff?

Description

selected.

Interval Unit No Yes Time unit for timer, it is available only when the 
trigger event Local is selected.

End After No Yes Specify the action after the receipt of data, the 
following are the valid values available only when 
the trigger event Local is selected.

• Never: The connection never ends

• Occurrences: When Occurrences is 
selected, the Occurrences field is enabled, 
enter the preferred Occurrences value.

• End time: When End time is selected, the 
End time field is enabled. You can choose a 
date and time.

Tags

Conversations
You can use the Conversations tab to initiate or join a conversation.

Conversations receive a message after the creation of the process instance, which is 
initiated or joined by an activity. This activity can be used to initiate a conversation. Click 
the Add New Conversation  icon to initiate a conversation. For more information about 
conversations, see TIBCO ActiveMatrix BusinessWorks™ Application Design.

Output
The following is the output for the activity.
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Output 
Item

Data Type Description

Header String  l SAPName?: The SAP system ID  with which the activity is 
performed.

 l ODPSource?: Name of the ODP source.

 l ODPMode?: Type of  extract data from SAP ODP source, the 
valid values include Full and Delta.

 l SubscriberName:

 l timestamp?: The time at which an event occurs.

 l date?: The date when an event is performed.

 l time?: The time when an event is performed.

 l messageID?:  It is a Unique ID for an event.

Important: When data from an ODP source is processed 
across multiple jobs, the messageID value would be the 
same in all the jobs.

 l recordCount?: The count of the records that a job contains.

Based on the output format selected, the Output item and 
corresponding Body Data section would undergo changes 
respectively.

 l For JSON:

data?: The Change Data Capture data is transformed into a 
JSON object that is subsequently serialized into a string.

 l For XML:

Records: The records of the data section.

Items: One or more records from the SAP ODP source.  The 
schema is dependent on the schema of the ODP source.
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Output 
Item

Data Type Description

 l For  Avro:

data?: The Change Data Capture data is transformed into a 
JSON object that is subsequently serialized into Avro as a 
binary string.

Fault
The Fault tab lists exceptions that are generated by this activity.

Error Schema Element Data Type Description

msg  string   The error message is returned by the plug-in. 

msgCode string The error code returned by the plug-in.

 l CDCPluginException: The exception is generated when the plug-in cannot send the 
request or parse the  response.

 l CDCSAPException: The exception is generated when any SAP related error occurs.

SAP ODP Change Event Information
To identify the type of change event from the SAP ODP Source, specific fields are included 
in the activity output, regardless of the output format. These fields are sourced directly 
from the ODP Source.

SAP ODP Field Data 
Type

Description

ODQ_ String Identifies the type of change event. Possible values are 'C' for 
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SAP ODP Field Data 
Type

Description

CHANGEMODE create, 'U' for update, and 'D' for delete. 

ODQ_
ENTITYCNTR 

Integer Value sent from SAP ODP Source is used in conjunction with 
the ODQ_CHANGEMODE to further describe the change event.

Supported Datatypes

Datatype Meaning

INT1 1-byte integer

INT2 2-byte integer

INT8 4-byte integer

DEC Decimal floating point number stored in BCD format

DF16_DEC Decimal floating point number stored in binary format 

DF16_RAW Decimal floating point number stored in binary format 

DF34_DEC Decimal floating point number stored in BCD format

DF34_RAW Decimal floating point number stored in binary format 

FLTP Binary floating point number

CHAR Character string

LCHR Long character string

STRING Character string

SSTRING Character string (CLOB)
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Datatype Meaning

RAW Byte string

LRAW Long byte string

RAWSTRING Byte string (BLOB)

DATS Date in the format YYYYMMDD

TIMS Time in the format HHMMSS

ACCP Posting period in the format YYYYMM

NUMC Numeric text

CLNT Client

LANG Language key

CURR Currency field in BCD format

CUKY Currency key for currency fields

QUAN Quantity field in BCD format

UNIT Unit key of a quantity field

Preparing SAP System
Before using the plug-in, you have to ensure that your SAP account and your SAP system 
meet the following requirements.
No modifications of code are required in the SAP system itself.

SAP Account Requirements
An SAP account is required to connect to the SAP system to communicate with the plug-in.

Before configuring the plug-in at design time, ensure that your SAP account and your SAP 
system meet the following requirements:
Your SAP account has access to a dedicated SAP application server and has permission to 
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extract metadata for SAP ODP Datasources or Extractors  by using TIBCO Business Studio 
for BusinessWorks.

 l If you want to use different connections between design-time and runtime, obtain 
the relevant connection information.

 l If you want to configure a load-balanced inbound activity, obtain the parameters 
used to connect to a Messaging Server for a specific Logon Group from the SAP 
Connection shared resource.

 l Your SAP account has authorization from the SAP system administrator to execute 
RFCs in function group RODPS_REPL in the SAP system.

CDC NoSql DB Listener activity
The CDC-NoSql DB Listener activity listens to the operations performed on database tables. 
When CDC is enabled for a table the data change events for the respective table are 
logged. The Debezium engine collects these data change event logs and returns the details 
of the data change.

By default, the plug-in initializes Debezium to capture change data events for Insert (i), 
Update (u), Delete (d), and Snapshot operations.

However, you can pass the appropriate Operation Options value so that the data changes 
specific to these activities performed on a table are captured.

Note: 
 l The CDC NoSql DB listener activity does not support concurrency, as the 

events are read sequentially.

 l The Flowlimit is not supported in the CDC NoSql DB listener activity due 
to the behavior of the Debezium engine.

 l If you have issues running the NoSQL Cassandra Database activity, see the 
Important Note on mandatory VM arguments in the Deploying an 
Application section.

General
The General tab contains the following fields:
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For MongoDB

For Cassandra

Property Module 
Property?

Visual 
Diff?

Description Applies To

Name No Yes Name of the palette activity Cassandra, 
MongoDB

NoSQL 
Connection

Yes Yes The name to be displayed as the label 
for the NoSql connection resource.

Cassandra, 
MongoDB

Table Name Yes Yes The table name displayed as the label. 
Multiple tables can be specified in a 
comma-separated list.

Note: If a listening table is deleted 
from the database, the plug-in does 
not generate any exception.

Cassandra, 
MongoDB
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Property Module 
Property?

Visual 
Diff?

Description Applies To

Output 
Format

No Yes The following are the output formats:

 l JSON

 l XML

Cassandra, 
MongoDB

Max. Tasks Yes Yes This flag, related to the task.max Kafka 
property, specifies the maximum number 
of workers a connector or job can run.

MongoDB

HTTP Port Yes Yes Specify the port on which Cassandra is 
running.

Cassandra

Cassandra 
Config. File 
Path

Yes Yes Specify the path to the cassandra.yaml 
file from the Cassandra installation 
directory.

Cassandra

CommitLog 
Relocation 
Directory

Yes Yes Specify the path to the commitlog 
directory created for storing Cassandra 
commit logs.

Cassandra

Process in 
Real Time

Yes Yes Set this field to enable the 
commit.log.real.time.processing.ena
bled flag, which helps eliminate 
processing delays.

Cassandra

Latest 
CommitLog 
Only

Yes Yes Enable this flag to process only the latest 
commit log.

Cassandra

The following fields are displayed only when the Enable Fault Tolerance checkbox is 
selected:

Property Module 
Property? 

Visual 
Diff?

Description

Engine Name Yes Yes Specify the name of the Debezium 
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Property Module 
Property? 

Visual 
Diff?

Description

engine.

Offset File Path Yes Yes Specify the file path for storing the 
offset.

Flush Interval(ms) Yes Yes Specify the interval at which to attempt 
committing offsets for tasks.

Topic Prefix 
Name

Yes Yes Specify the topic prefix for the 
topic.prefix property in Debezium.

Description
Provide a short description for the activity.

Advanced
The Advanced tab contains the following fields:

Property Module 
Property? 

Visual 
Diff?

Description

Sequence 
Key

No Yes This field contains an XPath expression that 
specifies which processes should run in sequence. 
Process instances with sequencing keys evaluating 
to the same value, are executed sequentially in the 
sequence the process instance was created.

Custom Job 
Id

No Yes This field contains an XPath expression that 
specifies a custom ID for the process instance. 

Operation 
Options

Yes Yes Facilitate the selection of the appropriate 
operation.
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Property Module 
Property? 

Visual 
Diff?

Description

 l Insert: When the Insert checkbox is selected 
and insert operation is performed on DB, we 
receive the event with Opcode value i.

 l Update: When the Update checkbox is 
selected and update operation is performed 
on DB, we receive the event with Opcode 
value u.

 l Delete: When the Delete checkbox is 
selected and delete operation is performed 
on DB, we receive the event with Opcode 
value d.

 l Snapshot: Scans database tables or objects 
and creates  reference point to capture 
change data information and we receive the 
event with Opcode value r.

Module Property

Any additional database or Debezium property can be specified using the 
com.tibco.bw.palette.cdc.additionalDbProperties module property.

Note: 
 l If you specify an include column list in the module property and exclude 

the primary key column, the primary key is not shown in the activity 
output.

 l When the provide.transaction.metadata property is set to true, 
transaction metadata is not returned in the response.

 l You can provide multiple additionalDbProperties by separating them 
with a semicolon (for example: prop_name1=prop_value1;prop_
name2=prop_value2).
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Tags

Conversations

You can use the Conversations tab to initiate or join a conversation.

Conversations receive a message after the creation of the process instance, which is 
initiated or joined by an activity. This activity can be used to initiate a conversation. Click 
the Add New Conversation  icon to initiate a conversation. For more information about 
conversations, see TIBCO ActiveMatrix BusinessWorks™ Application Design.

Output
The following is the output for the activity.

Output 
Item

Data Type Description

Global 
Scope

String The Global scope checkbox makes output variable of the activity 
from current scope to global level which is at the process level.

item? String
Header: Based on the output formats, the Output item differs

 l keySpaceName?: The name of the keyspace used for the 
created session.

 l databaseName?: The database name with which the 
activity is performed.

 l table?: The table on which operations are performed.

 l collection?: The name of MongoDB collection/table.

 l opcode?: The opcode value that is set to perform a 
specific operation.

 l timestamp?: The time required to perform the specific 
activity.
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Output 
Item

Data Type Description

 l date?: The date when an event is performed.

 l time?: The time at which an event occurs.

 l messageID? It is an Unique ID for an event.

Body: Data of records that undergo change based on the 
output formats that are chosen.

 l For JSON:

data?: Depending on the insert, update, and delete 
operations performed, we obtain respective source and 
target values.

 o For Insert operation the source is null, target 
consists of values which are inserted.

 o For Update operation the source is null, target 
consists of new updated values.

 o For Delete operation the source is null, target 
consists of deleted values.

 l For XML:

Source Column and Target Column: Depending on the 
insert, update, and delete operations performed, we 
obtain respective Source Column and Target Column 
values.

 o For Insert operation the Source Column is null, 
whereas the Target Column consists of values 
which are inserted.

 o For Update operation the Source Column is null 
and the Target Column consists of new updated 
values.

 o For Delete operation the Source Column is null 
and the Target Column consists of deleted values.
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Fault
The Fault tab lists exceptions that are generated by this activity.

Error Schema Element Data Type Description

msg string The error message returned by the plug-in.

msgCode string The error code returned by the plug-in.

 l CDCPluginException: The exception is generated when the plug-in cannot send the 
request or parse the  response.

 l CDCNoSqlDBException: The exception is generated when any database related error 
occurs.
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Working with Sample Projects
The ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture packages sample 
projects, which helps to understand how TIBCO ActiveMatrix BusinessWorks™ Plug-in for 
Change Data Capture works. The following sample project is located in the <TIBCO_
HOME>/bw/palettes/cdc/<version_number>/samples directory:

 l Sample Plug-in Project for the CDC-DB Listener Process Activity

 l Sample Plug-in Project for the CDC-SAP Listener Process Activity

 l Sample Plug-in Project for the CDC-Cassandra DB Listener Process Activity

 l Sample Plug-in Project for the CDC-MongoDB Listener Process Activity

Importing Sample Projects

Before you begin
Before running the project, you must import the sample projects to TIBCO Business Studio 
for BusinessWorks.

Procedure
 1. Depending on the platform applicable to your plug-in, start TIBCO Business Studio 

for BusinessWorks:

Platform Step

Microsoft 
Windows

Click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business 
Studio <version> > Studio for Designers

Linux or 
macOS

Run the TIBCO Business Studio for BusinessWorks executable file in the 
TIBCO_HOME/studio/<version>/eclipse directory.
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For the list of platforms supported by your plug-in, see the Readme file.

 2. Click File > Import. 

 3. In the Import dialog, expand the General folder and select the Existing Studio 
Projects into Workspace item. Click Next. 

 4.  Next to the Select root directory field, click Browse to locate the samples. Click 
Finish.  

The sample project is stored in the <TIBCO_HOME>\bw\palettes\cdc\<version_
number>\samples directory. 

Result
The sample project is imported to TIBCO Business Studio for BusinessWorks.
 

Setting Up a Project

Before you begin
Ensure that you have imported the sample project as described in Importing Sample 
Projects.

Procedure
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 1. Expand the imported project in the Project Explorer view.

 2. Expand the Module Descriptors resource, and then double-click Module Properties.

 3. In the Module Properties panel, complete the following tasks:

 l Enter the Username

 l Enter the Password

 l Select the Database Driver

 l Select the Database URL

 l Select the TableName

 4. Expand the resource folder and double-click JDBC connection resource.

 5. Click the Test Connection on the Configuration tab.

 6. From the menu bar, click File > Save to save the project.

Running the Project
After importing the sample project, you can run the project to see how the plug-in works.

Before you begin
Ensure that you have imported the sample project to TIBCO Business Studio as described 
in    Importing Sample Projects.    

Procedure
 1. From the menu, click      Run      > Run Configurations.      

 2. In the      Run Configurations dialog, expand      BusinessWorks Application, and then click       
BWApplication.      

 3. On the      Applications tab, all the sample applications are selected. You can clear the 
sample applications that you do not want to run.      

 4. Click      Run to run the process.      

 5. Click the stop       icon to stop the process.      
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Sample Plug-in Project for the CDC-DB 
Listener Process Activity
The examples mentioned in this section for the CDC-DB Listener activity can be found in 
the Examples.zip file available in the samples directory of the plug-in.
Also, there are five process provided in the sample for each supported database.

You can use the example    MSSQL_Process.bwp to understand how the CDC-DB Listener  
Process activity behaves for MSSQL DB. 

You can use the example    Oracle_Process.bwp to understand how the CDC-DB Listener  
Process activity behaves for Oracle DB.
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You can use the example    DB2_Process.bwp to understand how the CDC-DB Listener  
Process activity behaves for IBM DB2.
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You can use the example    example.MySQL_Process.bwp to understand how the CDC-DB 
Listener  Process activity behaves for MySQL database.
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You can use the example    example.PostgreSQL_Process.bwp to understand how the CDC-
DB Listener  Process activity behaves for PostgreSQL database.
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Sample Plug-in Project for the CDC-SAP 
Listener Process Activity
The examples mentioned in this section for the CDC-SAP Listener activity can be found in 
the CDC_SAP_Examples.zip file available in the samples directory of the plug-in.

Important: In order to run this example, the TIBCO AtiveMatrix BusinessWorks 
Plug-in for SAP Solutions must be installed in the same BusinessWorks home.

You can use the example    SAP_SalesOrder_Changes.bwp to understand how the CDC-SAP 
Listener  Process activity behaves for SAP ODP Framework.
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Sample Plug-in Project for the CDC-
Cassandra DB Listener Process Activity
The example mentioned in this section for the CDC-NoSql-DB Listener activity can be found 
in the CDC_NoSQLDB_Examples.zip file available in the samples directory of the plug-in.

You can use the example NoSQL_Cassandra.bwp to understand how the CDC-NoSql-DB 
Listener  Process activity behaves for Apache Cassandra.
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Sample Plug-in Project for the CDC-
MongoDB Listener Process Activity
The example mentioned in this section for the CDC-NoSql-DB Listener activity can be found 
in the CDC_NoSQLDB_Examples.zip file available in the samples directory of the plug-in.

You can use the example NoSQL_MongoDB.bwp to understand how the CDC-NoSql-DB 
Listener  Process activity behaves for MongoDB.
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Log Management
When an error occurs, you can check logs to trace and troubleshoot the plug-in exceptions.

A logback.xml file is in the <TIBCO_HOME>\bw\<version_number>\config\design\logback 
directory. Update this file to set up log levels and export logs to a file.

By default, error logs are displayed in the Console view when you run a process in debug 
mode. You can change the log level of the plug-in to trace different messages and export 
logs to a file. Different log levels correspond to different messages, as described in Log 
Levels.

Log Levels
Different log levels include different information.  The plug-in supports the following log 
levels.

Property Description

Trace Includes all information regarding the running process.

Debug Indicates a developer-defined tracing message.

Info Indicates normal plug-in operations. No action is required. A tracing message 
tagged with Info indicates that a significant processing step is reached, and 
logged for tracking or auditing purposes. Only info messages preceding a 
tracking identifier are considered as significant steps.

Warn Indicates that an abnormal condition occurred. Processing continues, but for 
best practice, you can contact the administrator to investigate it.

Error Indicates that an unrecoverable error occurred. Depending on the severity of 
the error, the plug-in might continue with the next operation or might stop.
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Setting Up Log Levels
In the logback.xml file, you can configure a different log level for the plug-in and plug-in 
activities to trace different messages.

If you do not configure any log levels, the plug-in uses the default log level of TIBCO 
ActiveMatrix BusinessWorks™. The default log level is Error.

Procedure
 1. Navigate to the <BW_HOME>\bw\<version_number>\config\design\logback directory 

and open the logback.xml file.

 2. Add the following node in the BusinessWorks Palette and Activity loggers area to 
specify a log level for the plug-in:

<logger name="com.tibco.bw.palette.cdc.runtime"> 
    <level value="DEBUG"/>
 </logger>

The value of the level element can be Error, Info, or Debug.

Note: If you set the log level to Debug, the input and output for the plug-in 
activities are also displayed in the Console view. For more details about 
each log level, see Log Levels.

 3. Optional: Add different nodes in the BusinessWorks Palette and Activity loggers 
area to specify different log levels for the activities.

 l For the TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture 
Connection shared resource, add the following node:

<logger 
name="com.tibco.bw.sharedresource.cdcresource.runtime">
<level value="DEBUG"/>
</logger>

 l For the CDC-SAP Listener activity, add the following node:

<logger name="com.tibco.bw.palette.cdc.runtime.saplistener">
<level value="DEBUG"/>
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</logger>

 l For the CDC-DB Listener activity, add the following node:

<logger name="com.tibco.bw.palette.cdc.runtime.dblistener"> 
<level value="DEBUG"/>
</logger>

Note: The activities that are not configured with specific log levels 
use the log level configured for the plug-in.

 4. Save the file.

Note: For Avro Output Format when you set the plug-in logger to TRACE, 
by using additional 
com.tibco.bw.palette.cdc.AvroDeserializationOn=true Arguments in 
the TIBCO Business Studio™ then in logs you can see Deserialized Source 
or Target Data Avro message.

Exporting Logs to a File
To export plug-in logs to a file, modify the logback.xml.

Procedure
 1. Navigate to the <BW_HOME>\bw\<version_number>\config\design\logback directory 

and open the logback.xml file.

 2. Add the following node  to specify the file location:

<appender name="FILE" class="ch.qos.logback.core.FileAppender">
    <file>c:/.log</file>
       <encoder>
         <pattern>%d{HH:mm:ss.SSS} [%thread] %-5level %logger
{36}-%msg%n</pattern>
       </encoder>
 </appender>
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The file tag defines the location to which the log is exported, and the value in the 
tag is the absolute path of the file.

Note: You also need to add the file name in the file path.

 3. To enable exporting the logs to a file, add the following node to the root node at the 
end of the logback.xml file:

 <appender-ref ref="FILE" />
 
 <root level="DEBUG">
    <appender-ref ref="STDOUT" />
    <appender-ref ref="FILE" />
 </root>

 4. Save the file.
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Error Codes
The following table lists error codes, a detailed explanation of each error, and where 
applicable, ways to resolve different errors.

Caution: Code snippets in the PDF can have undesired line breaks because of 
space constraints. Before directly copying and running them in your program, 
they must be verified.

TIBCO-BW-PALETTE-CDC Loggers

Role: Trace

Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
100000

start {0} CDC Activity

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100001

stop {0} of CDC Activity

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100002

Initiate CDC {0} Activity

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100003

Destroy CDC {0} Activity

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None
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Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
100004

Event received from DBZ 
with MessageID:{0} for 
{1} Activity

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100005

{0} Activity prepared the 
output and sending to 
activity output tab for 
MessageId:{1}

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100006

Deserialized {0} avro 
message : {1}

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100007

Connection to Oracle done

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100008

Connection to Oracle 
failed due to {0}

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100009

Current operation is {0}

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100010

Trace CDC-
DBListener

Includes all 
information 

None



TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture User Guide

82 | Error Codes

Error code and error 
message

Role Category Description Solution

Current operation data is 
{0}

regarding the 
running process.

TIBCO-BW-PALETTE-CDC-
100011

The module property, {0} 
passed the following 
property values: {1}

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100012
The Process Nullable 
Columns For Avro is {0}

Trace CDC-
DBListener

Includes all 
information 
regarding the 
running process.

None

TIBCO-BW-PALETTE-CDC-
100013

The values of DB 
encryption, trust server 
certificate and offset 
flush interval are: {0}, 
{1} and {2}.

Trace CDC-
DBListener

The values of DB 
encryption, trust 
server certificate 
and offset flush 
interval are set to 
the following 
values.

None

TIBCO-BW-PALETTE-CDC-
100014

Table {0} is available in 
{1} DB

Trace CDC-
DBListener

Table is available in 
DB.

None

TIBCO-BW-PALETTE-CDC-
100015 Fetching data from 
ODP source {0}

Trace BW-Plug-in Fetching data from 
the selected table.

None

TIBCO-BW-PALETTE-CDC-
100016 Fetched data from 
ODP source {0}, Number of 
rows: {1}, Elapsed Time: 
{2} ms.

Trace BW-Plug-in Number of rows 
fetched from the 
given table.

None
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Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
100017 Data processing is 
complete for ODP source 
{0}, Elapsed Time: {1} 
ms.

Trace BW-Plug-in Inform about data 
processing for the 
ODP source.

None

Role: Debug

Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-
CDC-200000 {0}

Debug BW-Plug-in Generic debug message. None

TIBCO-BW-PALETTE-
CDC-200001

CDC Activity {0} 
generated output:\n
{1}

Debug DBListener Activity output schema. None

TIBCO-BW-PALETTE-
CDC-200002

Preparing the 
output schema for 
{0} Activity.

Debug DBListener Preparing the output schema 
for activity.

None

TIBCO-BW-PALETTE-
CDC-200003

Returning the 
ActivityOutput 
element:{0}.

Debug DBListener Printing activity output 
element.

None

TIBCO-BW-PALETTE-
CDC-200004

Initializing 
Debezium Engine 

Debug DBListener Debezium engine is initialized 
with the mentioned table in 
the configuration.

None
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Error code and error 
message

Role Category Description Solution

for {0} Listener 
thread:{1} to 
listen the data 
for table: {2}

TIBCO-BW-PALETTE-
CDC-200005

Creating Debezium 
Engine for {0} 
Listener thread:{1} 
to listen the data 
for table: {2}

Debug DBListener Debezium engine is created 
with the mentioned table in 
configuration.

None

TIBCO-BW-PALETTE-
CDC-200006

Starting Debezium 
Engine for {0} 
Listener thread:{1} 
to listen the data 
for table: {2}

Debug DBListener Debezium engine is started 
with mentioned table in 
configuration.

None

TIBCO-BW-PALETTE-
CDC-200007

Response received 
from DBZ:{0}

Debug DBListener Event response received from 
Debezium engine.

None

TIBCO-BW-PALETTE-
CDC-200008

Data retrieved 
from DBZ response: 
{0}

Debug DBListener Data retrieved from 
Debezium engine.

None

TIBCO-BW-PALETTE-
CDC-200009

Module property 
{0} is defined but 

Debug BW-Plug-in Module property 
com.tibco.bw.palette.cdc.
enableOutputValidation is 
set to false, therefore output 
validation defaulted to 

None
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Error code and error 
message

Role Category Description Solution

it is set to false 
hence output 
validation is 
defaulted to 
platform which is 
set to {1}.

platform.

TIBCO-BW-PALETTE-
CDC-200010

Module property 
{0} is defined and 
set to to {1}.

Debug BW-Plug-in Module property 
com.tibco.bw.palette.cdc.
enableOutputValidation is 
set to false or true.

None

TIBCO-BW-PALETTE-
CDC-200011

Module property 
{0} is not 
defined, so output 
validation is 
defaulted to 
platform which is 
set to {1}.

Debug BW-Plug-in Module property 
com.tibco.bw.palette.cdc.
enableOutputValidation is 
not defined, therefore output 
validation defaulted to 
platform.

None

TIBCO-BW-PALETTE-
CDC-200012

Error encountered 
while fetching 
module property 
{0}, so returning 
additional 
properties value 
{1}.

Debug CDC-
DBListener

Error occurred while module 
property 
com.tibco.bw.palette.cdc.
additionalDbProperties 
fetching.

None

TIBCO-BW-PALETTE-
CDC-200013

{0} is set to {1}.

Debug CDC-
DBListener

Heart beat property set to 
mentioned value.

None
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Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-
CDC-200014

Got exception 
while reading {0} 
module property. 
Exception is {1}. 
Setting {0} to 
default value {2}.

Debug CDC-
DBListener

Exception got while reading a 
module property. Setting to 
the default value for the 
module property.

None

TIBCO-BW-PALETTE-
CDC-200015

{0} value is less 
than {1}. Setting 
{0} default value 
to {2}.

Debug CDC-
DBListener

The given value is less than 
the minimum threshold 
value. Therefore setting the 
value to the minimum 
threshold value.

None

TIBCO-BW-PALETTE-
CDC-200016

DBListenerHBThread 
sleeping for 
interval {0} 
milliseconds....

Debug CDC-
DBListener

Heart beat thread is sleeping 
for mentioned milliseconds.

None

TIBCO-BW-PALETTE-
CDC-200017

DBListenerHBThread 
is updated now and 
current captured 
messageID is {0}

Debug CDC-
DBListener

Heart beat thread is polling. None

TIBCO-BW-PALETTE-
CDC-200018

DBListenerHBThread 
polling....

Debug CDC-
DBListener

Heart beat thread updated 
the heat beat table. A new 
messageID is captured.

None

TIBCO-BW-PALETTE- Debug CDC- The heartbeat thread checks None
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Error code and error 
message

Role Category Description Solution

CDC-200019

DBListenerHBThread 
is updated {0} 
number of rows

DBListener and displays the number of 
rows updated for the 
performed operation.

TIBCO-BW-PALETTE-
CDC-200020

DBListenerHBThread 
number of attempts 
decrement to {0}

Debug CDC-
DBListener

The heartbeat thread 
attempts to check for a 
heartbeat.

None

TIBCO-BW-PALETTE-
CDC-200023 Input of 
activity {0}: {1}

Debug BW-Plug-in Shows the input JSON polled 
by the Debezium engine.

None

TIBCO-BW-PALETTE-
CDC-200024 Output of 
activity {0}: {1}

Debug BW-Plug-in Shows the output schema of 
the table rows fetched by the 
Debezium engine.

None

Role: Info

Error code and error message Role Category Description Solution

TIBCO-BW-PALETTE-CDC-300000

Starting {0} Listener 
thread:{1} to listen the 
data for table:{2}

Info CDC-
DBListener

Starting a DB 
listener thread 
and listening to 
mentioned 
tables.

None

TIBCO-BW-PALETTE-CDC-300001

{0} Listener thread:{1} is 
stopped, which listening the 
data for table:{2}

Info CDC-
DBListener

Stopped DB 
listener thread 
and listening to 
mentioned 
tables.

None

TIBCO-BW-PALETTE-CDC-300002 Info CDC- Mentioned Java None
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Error code and error message Role Category Description Solution

Java property {0} is set to 
{1}

DBListener property is set to 
mentioned value.

TIBCO-BW-PALETTE-CDC-300003

Java 
propertDBListenerHBThread 
started....}

Info CDC-
DBListener

Heart beat thread 
is started.

None

TIBCO-BW-PALETTE-CDC-300004

DBListenerServiceThread 
stopping....

Info CDC-
DBListener

Heart beat thread 
is stopping.

None

TIBCO-BW-PALETTE-CDC-300005

DBListenerServiceThread 
starting....

Info CDC-
DBListener

Heart beat thread 
is starting.

None

TIBCO-BW-PALETTE-CDC-300006

DBListenerServiceThread 
starting....

Info CDC-
DBListener

Heat beat thread 
stopped.

None

Role: Warn

Error code and 
error message

Role Category Description Solution

TIBCO-BW-
PALETTE-CDC-
400001

Error while 
deserializing 
avro message : 
{0}

Warn CDC-
DBListener

Indicates that an abnormal 
condition has occurred. 
Processing continues, however 
to investigate the issue further, 
contact the administrator.

Check before 
and after 
JSON, also 
exception 
from Avro 
library.

TIBCO-BW-
PALETTE-CDC-
400002

Warn CDC-
DBListener

Indicates that an abnormal 
condition has occurred. 
Processing continues, however 

Check before 
and after 
JSON, also 
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Error code and 
error message

Role Category Description Solution

Error while 
serializing 
avro message : 
{0}

to investigate the issue further, 
contact the administrator.

exception 
from Avro 
library.

TIBCO-BW-
PALETTE-CDC-
400003

Avro data is 
empty

Warn CDC-
DBListener

Error while serializing Avro 
output format data.

Check before 
and after 
JSON, also 
exception 
from Avro 
library.

Role: Error

Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
500001

Error while parsing 
the received data and 
preparing the output 
tab, error:{0}

Error BW-Plug-in Error while parsing 
JSON or preparing 
activity output.

None

TIBCO-BW-PALETTE-CDC-
500002

Exception occurred 
while creating 
Debezium Engine : {0}

Error BW-Plug-in Error occurred while 
initializing the 
Debezium engine.

Check the 
configuration of 
the plug-in.

TIBCO-BW-PALETTE-CDC-
500003

The {0} db is not 
supported by CDC-DB 
Listener Activity.

Error BW-Plug-in Unsupported DB 
details given for 
DBListener activity.

Check DB 
configuration.
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Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
500004

The Table name field 
can't be null or blank 
in the CDC-DB Listener 
Activity

Error BW-Plug-in Table name is null 
or blank.

Give the table 
name under the 
DBListener 
activity General 
tab.

TIBCO-BW-PALETTE-CDC-
500005

Error while parsing 
the received data and 
retrieving the data, 
error:{0}

Error BW-Plug-in Error while parsing 
output JSON.

Put the valid 
table name in 
the Table Name 
field.

TIBCO-BW-PALETTE-CDC-
500006

Exception occurred 
while closing Debezium 
Engine : {0}

Error BW-Plug-in Error occurred while 
closing the 
Debezium engine.

None

TIBCO-BW-PALETTE-CDC-
500007

Exception occurred 
while handling DB 
Listener activity : 
{0}

Error BW-Plug-in Exception occurred 
while handling DB 
listener activity.

None

TIBCO-BW-PALETTE-CDC-
500008

Source data is null 
for changed event, 
cannot process change 
request

Error BW-Plug-in Data coming from 
the Debezium 
engine is null.

None

TIBCO-BW-PALETTE-CDC-
500009

Error BW-Plug-in Table is not 
available in the 

Create 
respective table 
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Error code and error 
message

Role Category Description Solution

Table {0} is not 
available in {1} DB

respective DB. or give 
permission to 
access table.

TIBCO-BW-PALETTE-CDC-
500010

Connection to {0} 
failed due to {1}

Error BW-Plug-in Connection to the 
database failed due 
to the issue 
mentioned.

 

TIBCO-BW-PALETTE-CDC-
500011

Issue faced while 
closing connection 
with {0} DB; facing 
issue as {1}

Error BW-Plug-in Issue faced while 
closing connection 
with respective DB; 
facing issue 
mentioned in error.

Check database 
admin for more 
details.

TIBCO-BW-PALETTE-CDC-
500012

DBListenerHBThread 
interrupted due to {0}

Error BW-Plug-in DBListenerHBThread 
interrupted due to 
mentioned error.

None

TIBCO-BW-PALETTE-CDC-
500013 Client 
Connection not 
available in the 
activity {0}

Error BW-Plug-in The CDC shared 
resource is 
unavailable.

Verify the 
activity 
configuration 
and make sure 
that the CDC 
resource is 
configured 
properly.

TIBCO-BW-PALETTE-CDC-
500014 Failed to 
extract the data from 
ODP source, due to 
{0}.

Error BW-Plug-in The data extraction 
failed.

Check the error 
message 
provided and 
take action 
accordingly.
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Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
500015 Failed to open 
the session, Error 
{0}.

Error BW-Plug-in The session to SAP 
ODP Source failed to 
open.

Check the error 
message 
provided and 
take action 
accordingly.

TIBCO-BW-PALETTE-CDC-
500016 Failed to fetch 
ODP source, Error {0}.

Error BW-Plug-in The fetch to SAP 
ODP Source failed.

Check the error 
message 
provided and 
take action 
accordingly.

TIBCO-BW-PALETTE-CDC-
500017 Failed to close 
the session, Error 
{0}.

Error BW-Plug-in The session to SAP 
ODP Source failed to 
close.

Check the error 
message 
provided and 
take action 
accordingly.

TIBCO-BW-PALETTE-CDC-
500018 The SAP trigger 
event is selected for 
the activity {0}, 
however, server 
connection is not 
available.

Error BW-Plug-in The server 
connection is not 
available for the 
activity.

Check the error 
message 
provided and 
take action 
accordingly.

TIBCO-BW-PALETTE-CDC-
500019 The Engine Name 
field can't be null or 
blank in the CDC-DB 
Listener Activity when 
FT mode is enabled.

Error BW-Plug-in Engine name field is 
empty when FT 
mode is enabled.

Provide a Valid 
engine name.

TIBCO-BW-PALETTE-CDC-
500020 The Offset File 
Path field can't be 
null or blank in the 
CDC-DB Listener 

Error BW-Plug-in The file offset path 
field is empty when 
FT mode is enabled.

Ensure that the 
offset path is 
valid & exist.
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Error code and error 
message

Role Category Description Solution

Activity when FT mode 
is enabled.

TIBCO-BW-PALETTE-CDC-
500021 The Flush 
Interval field can't 
be less than zero in 
the CDC-DB Listener 
Activity when FT mode 
is enabled.

Error BW-Plug-in Provided negative 
value for flush 
interval  when FT 
mode is enabled.

Keep the flush 
interval greater 
than 0 when FT 
mode is 
enabled.

TIBCO-BW-PALETTE-CDC-
500022 The Server ID 
field can't be less 
than 10000 in the CDC-
DB Listener Activity 
when FT mode is 
enabled.

Error BW-Plug-in Server ID field less 
than 10000  when FT 
mode is enabled.

Provide a Server 
ID field value 
greater than 
10000  when FT 
mode is 
enabled.

TIBCO-BW-PALETTE-CDC-
500023 The Topic 
Prefix field can't be 
null or blank in the 
CDC-DB Listener 
Activity when FT mode 
is enabled.

Error BW-Plug-in Topic prefix field is 
empty when FT 
mode is enabled.

Provide the 
appropriate 
value for Topic 
Prefix when FT 
mode is 
enabled.

TIBCO-BW-PALETTE-CDC-
500024 The Schema 
History File Path 
field can't be null or 
blank in the CDC-DB 
Listener Activity when 
FT mode is enabled.

Error BW-Plug-in The schema history 
file path field is 
empty when FT 
mode is enabled.

Provide 
appropriate 
value for 
schema history 
file path when 
FT mode is 
enabled.

TIBCO-BW-PALETTE-CDC-
500025 The Offset File 
Path is not available.

Error BW-Plug-in The offset file path 
is invalid.

Ensure that a 
valid offset file 
path is 
provided.
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Error code and error 
message

Role Category Description Solution

TIBCO-BW-PALETTE-CDC-
500026 The Schema 
History File Path is 
not available.

Error BW-Plug-in The schema history 
file path is invalid.

Ensure that a 
valid schema 
history file path 
is provided.

TIBCO-BW-SR-CDCRESOURCE Loggers

Role: Error

Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-
000001 {0}

Error BW-Plug-in Generic error 
message

None

Role: Debug

Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-
200001 {0}

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-
200002 
Creating Shared Resource {0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-
200003 
Starting Shared Resource {0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-
200004

Updating Shared Resource {0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE- Debug BW-Plug-in Generic debug None
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Error code and error message Role Category Description Solution

200005 
Stopping Shared Resource {0}.

message

TIBCO-BW-SR-CDCRESOURCE-
200006 
Deleting Shared Resource {0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-
200007 
Properties in the connection 
string: {0}

Debug BW-Plug-in Generic debug 
message

None

Role: Info

Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-300001 
{0}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300002 
Using a dedicated connection

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300003 
Number of connections: {0}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300004 
Connection {0} State: Available

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300005
Client connection pool name: {0} 
updated successfully, connection 
count={1}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300006
Activated timer to check 
connectivity to R/3 for 
connection-pool {0}

Info BW-Plug-in Generic info 
message

None
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Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-300007
Reconnect succeeded on attempt 
{0} for connection {1}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300008
Activating connections 
associated to connection-pool 
{0}...

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300009
Reconnect attempt {0} for 
connection {1}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300010
Connection re-established

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300011
Connection disconnected

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300012
Cancelled to reconnect to client 
connection {0}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300013
ABAP Repository refreshed for 
client connection pool: {0}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300014
Start to clean SAP JCo 
repository {0} with type {1}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300015
Removed Function template {0} 
from SAP JCo Repository {1} with 
type {2}

Info BW-Plug-in Generic info 
message

None

TIBCO-BW-SR-CDCRESOURCE-300016
Finish cleaning SAP JCo 
repository {0} with type {1}

Info BW-Plug-in Generic debug 
message

None
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Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-300017
Cleared SAP JCo repository {0} 
of JCo Destination {1}

Info BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-300018
Using a load balancing 
connection

Info BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-300019
Creating a Server connection

Info BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-300020
Server connection pool: 
gatewayHost={0} gatewayService=
{1} programID={2} updated 
successfully, connection count=
{3}

Info BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-CDCRESOURCE-300021
Connection Manager stopped

Info BW-Plug-in Generic debug 
message

None

Role: Warn

Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-
400001 {0}

Warn BW-Plug-in Generic warning 
message

None

TIBCO-BW-SR-CDCRESOURCE-
400002 
Reconnect failed on attempt 
{0} for connection {1} will 
retry in {2} ms

Warn BW-Plug-in Show the status 
of the 
reconnection 
process

None

TIBCO-BW-SR-CDCRESOURCE-
400003 
Invalid JCo option(s) found. 
{0}

Warn BW-Plug-in Show the invalid 
JCo properties

None

Role: Error
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Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-
500001 
{0}

Error BW-Plug-in Generic error 
message

None

TIBCO-BW-SR-CDCRESOURCE-
500002 
Creating Shared Resource {0} 
failed.

Error BW-Plug-in Failed to 
create the 
shared 
resource.

Verify the 
configuration of 
the shared 
resource.

TIBCO-BW-SR-CDCRESOURCE-
500003
Starting Shared Resource {0} 
failed.

Error BW-Plug-in Failed to start 
the shared 
resource.

Verify the 
configuration of 
the shared 
resource and 
SAP 
connection.

TIBCO-BW-SR-CDCRESOURCE-
500004
Connection Error. Unable to 
create a connection with the 
target application {0} using 
connection parameters {1} 
and the target application 
error is {2}

Error BW-Plug-in Connection 
error

Verify the SAP 
connectivity.

TIBCO-BW-SR-CDCRESOURCE-
500005
Client connection pool name: {0} 
update error: {1}

Error BW-Plug-in Connection 
error

Check the error 
message 
provided.

TIBCO-BW-SR-CDCRESOURCE-
500006
Connection Error. {0} 
stopping due to persistent 
connection errors to the SAP 
R/3 system(s)

Error BW-Plug-in Connection 
error

None

TIBCO-BW-SR-CDCRESOURCE-
500007

Error BW-Plug-in Connection 
error

Check the 
configuration 
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Error code and error message Role Category Description Solution

Client connection {0} is 
invalid

and 
connectivity.

TIBCO-BW-SR-CDCRESOURCE-
500008
Failed to clean SAP JCo 
repository {0} of JCo 
Destination due to {1}

Error BW-Plug-in Failed to stop 
the shared 
resource

Check the error 
message 
provided.

TIBCO-BW-SR-CDCRESOURCE-
500009
Invalid destination {0} 
specified

Error BW-Plug-in Connection 
error

Check the error 
message 
provided.

TIBCO-BW-SR-CDCRESOURCE-
500010
Failed to access the field, 
error: {0}

Error BW-Plug-in The JCo 
property in 
question does 
not exist.

Verify the JCo 
property in 
question.

TIBCO-BW-SR-CDCRESOURCE-
500011
Server Error: {0}

Error BW-Plug-in Connection 
error

Check the error 
message 
provided.

TIBCO-BW-SR-CDCRESOURCE-
500012
Server Exception: {0}

Error BW-Plug-in Connection 
error

Check the error 
message 
provided.

TIBCO-BW-SR-CDCRESOURCE-
500013
Server connection pool: {0} 
suspended due to exceeded 
attempts to connect to SAP 
system

Error BW-Plug-in Connection 
error

Check the SAP 
connectivity.

TIBCO-BW-SR-CDCRESOURCE-
500014
Server connection {0} is 
invalid: {1}

Error BW-Plug-in Connection 
error

Check the error 
message 
provided.
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Error code and error message Role Category Description Solution

TIBCO-BW-SR-CDCRESOURCE-
500015
Server connection pool: 
gatewayHost={0} 
gatewayService={1} 
programID={2} update error: 
{3}

Error BW-Plug-in Connection 
error

Check the error 
message 
provided.

TIBCO-BW-SR-NOSQLRESOURCE Loggers

Role: Error

Error code and error message Role Category Description Solution

TIBCO-BW-SR-NOSQLRESOURCE-
000001 {0}

Error BW-Plug-in Generic error 
message

None

Role: Trace

Error code and error message Role Category Description Solution

TIBCO-BW-SR-NOSQLRESOURCE-
100001 {0}

Trace BW-Plug-in Generic trace 
message

None

Role: Debug

Error code and error message Role Category Description Solution

TIBCO-BW-SR-NOSQLRESOURCE-
200001 {0}

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-NOSQLRESOURCE-
200002

Creating Shared Resource 
{0}.

Debug BW-Plug-in Generic debug 
message

None
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Error code and error message Role Category Description Solution

TIBCO-BW-SR-NOSQLRESOURCE-
200003

Starting Shared Resource 
{0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-NOSQLRESOURCE-
200004

Updating Shared Resource 
{0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-NOSQLRESOURCE-
200005

Stopping Shared Resource 
{0}.

Debug BW-Plug-in Generic debug 
message

None

TIBCO-BW-SR-NOSQLRESOURCE-
200006

Deleting Shared Resource 
{0}.

Debug BW-Plug-in Generic debug 
message

None

Role: Error

Error code and error 
message

Role Category Description Solution

TIBCO-BW-SR-
NOSQLRESOURCE-
500001 {0}

Error BW-Plug-in Generic error 
message

None

TIBCO-BW-SR-
NOSQLRESOURCE-
500002

Creating Shared 
Resource {0} failed.

Error BW-Plug-in Failed to create 
the shared 
resource

Verify the 
configuration of the 
shared resource.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO 
Support, and join TIBCO Community.

How to Access TIBCO Documentation

 Documentation for TIBCO products is available on the Product Documentation website, 
mainly in HTML and PDF formats.    

 The Product Documentation website is updated frequently and is more current than any 
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the TIBCO ActiveMatrix BusinessWorks™ 
Plug-in for Change Data Capture Documentation page.

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:    

 l To access the Support Knowledge Base and getting personalized content about 
products you are interested in, visit our product Support website.     

 l To create a Support case, you must have a valid maintenance or support contract 
with a Cloud Software Group entity. You also need a username and password to log 
in to the product Support website. If you do not have a username, you can request 
one by clicking Register on the website.      

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-activematrix-businessworks-plug-in-for-change-data-capture
https://docs.tibco.com/products/tibco-activematrix-businessworks-plug-in-for-change-data-capture
https://support.tibco.com/
https://support.tibco.com/
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requests from within the      TIBCO Ideas Portal. For a free registration, go to      
TIBCO Community. 

https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED, 
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE 
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE 
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG 
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED  SOFTWARE IS NOT LICENSED TO BE USED OR 
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER 
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS 
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO 
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN 
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS 
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP 
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE 
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF 
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this 
document may be reproduced in any form without the written authorization of Cloud Software 
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, Business Studio, and TIBCO 
Business Studio  are either registered trademarks or trademarks of Cloud Software Group, Inc. in the 
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of 
their respective owners and are mentioned for identification purposes only. You acknowledge that all 
rights to these third party marks are the exclusive property of their respective owners. Please refer to 
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is 
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating 
system platforms for a specific software version are released at the same time. See the “readme” file 
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL


TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture User Guide

105 | Legal and Third-Party Notices

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES 
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED 
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN 
THE PRODUCT(S), THE PROGRAM(S),  AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY 
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer 
to the Virtual Patent Marking document located at https://www.cloud.com/legal.

Copyright © 2023-2025. Cloud Software Group, Inc. All Rights Reserved.

https://www.cloud.com/legal

	Contents
	Overview
	Getting Started
	Overview of TIBCO Business Studio for BusinessWorks
	Creating a Project
	Creating a JDBC Connection
	Configuring a Process
	Testing the Process
	Checking Output of an Activity


	Pushing an Application In TIBCO Platform
	Deploying an Application
	Generating an EAR File

	JDBC Connection Resource
	General
	JDBC Connection

	CDC Connection Resource
	General
	SAP Connection

	NoSQL Connection Resource
	General
	Cassandra Connection
	MongoDB Connection

	Palette
	CDC DB Listener Activity
	CDC Database Configuration Preferences
	General
	Description
	Advanced
	Tags
	Conversations
	Output
	Fault
	Support of Database Reconnection

	Supported Datatypes
	CDC-SAP Listener Activity
	General
	Description
	Advanced
	Tags
	Conversations
	Output
	Fault
	SAP ODP Change Event Information
	Preparing SAP System

	CDC NoSql DB Listener activity
	General
	Description
	Advanced
	Tags
	Output
	Fault


	Working with Sample Projects
	Importing Sample Projects
	Setting Up a Project
	Running the Project

	Sample Plug-in Project for the CDC-DB Listener Process Activity
	Sample Plug-in Project for the CDC-SAP Listener Process Activity
	Sample Plug-in Project for the CDC-Cassandra DB Listener Process Activity
	Sample Plug-in Project for the CDC-MongoDB Listener Process Activity
	Log Management
	Log Levels
	Setting Up Log Levels
	Exporting Logs to a File

	Error Codes
	TIBCO Documentation and Support Services
	Legal and Third-Party Notices

